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Introduction
The Civilization II Advancement Planner produces a road map of advancements based on 
specified advancement goals.    You can define multiple goals which can be specified as a 
civilization advancement, city improvement, military unit, wonder of the world, government, or unit
order.    The goals can also be filtered to show only goals from a selected knowledge category 
and/or period.

Commands
File menu
Plan menu
View menu
Help menu



File Menu Commands

The File menu offers the following commands:

New Creates a new advancement plan.
Open Opens an existing advancement plan.
Save Saves an opened advancement plan using the same file name.
Save As Saves an opened advancement plan to a specified file name.
Print Prints an advancement plan.
Print Preview Displays the advancement plan on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits Civilization II Advancement Planner.



Plan Menu Commands

The Plan menu offers the following commands:

Define Displays the Advancement Plan Dialog.
Reset Clears all the check boxes in the current plan.



View Menu Commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Help Menu Commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



New Command (File Menu)

Use this command to create a new plan in the Civilization II Advancement Planner.    

You can open an existing advancement plan with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open Command (File Menu)

Use this command to open an existing advancement plan.

You can create a new advancement plan with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open Dialog Box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which Civilization II Advancement Planner stores the file that you want to open. 

Directories
Select the directory in which Civilization II Advancement Planner stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save Command (File Menu)

Use this command to save the advancement plan to its current name and directory.    When you save a 
plan for the first time, Civilization II Advancement Planner displays the Save As dialog box so you can 
name your plan.    If you want to change the name and directory of an existing plan before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As Command (File Menu)

Use this command to save and name the active advancement plan.    Civilization II Advancement Planner 
displays the Save As dialog box so you can name your plan.    

To save a plan with its existing name and directory, use the Save command.



File Save As Dialog Box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a advancement plan with a different name.    A filename can contain up 
to eight characters and an extension of up to three characters.    Civilization II Advancement Planner 
adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the advancement plan.

Directories
Select the directory in which you want to store the advancement plan.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Exit Command (File Menu)

Use this command to end your Civilization II Advancement Planner session.    You can also use the Close 
command on the application Control menu.    Civilization II Advancement Planner prompts you to save 
plans with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Define Command (Plan Menu)

Use this command to display the Advancement Planning Dialog.

Shortcuts

Toolbar:



Define Plan Dialog

The define plan dialog allows you to add, delete, and reorder goals in your advancement plan.    In the 
upper left is the list of available goals.    This list is modified by the values selected in the Type, Period, 
and Knowledge Category fields.

The Type field defines the category of the goal.    The choices are Advancements, City Improvements, 
Units, Wonders of the World, Governments, Orders, and All.

The Period field defines the civilization time frame.    The choices are Ancient, Renaissance, Industrial 
Revolution, Modern, and All.

The Knowledge Category defines the application for the goal.    The choices are Military, Economic, 
Social, Academic, Applied, and All.

The Plan list is the list of goals which have been added to the plan.    Goals are added to the plan by 
selecting the goal in the Goals list and pressing the Add button.    The goal will be moved from the goals 
list to the plan list.    Once a goal is moved into the plan list it along with all the other goals associated with
it will no longer show up in the goals list.    For example if you move the advancement "Bronze Working" 
into the plan list you will not be able to find the unit "Phalanx" or the wonder "Colossus" in the goals list 
until "Bronze Working" is removed from the plan.

The three buttons below the Plan list modify the items in the list.    Delete moves the highlighted item from 
the Plan list back to the Goals list.    When the item is moved back all it's associated goals are added back
also.    The Up and Down buttons moved the selected item through the list.

The "Update Display" button takes the information in the plan list and generates the most efficient list of 
advancements you will need to obtain to meet the plan.    The list is displayed in the main window.    The 
amount of time needed to calculate the plan is dependent on the complexity of the advancements in the 
plan.    For example it takes much more time to generate the plan for "Advanced Flight" then it does for 



"Banking".

The "Close" button has the same function as the "Update Display" button except that the Define Plan 
dialog is closed when the button is pressed.

The Description field allows you to give a title to your plan.    This title will show up at the top of the 
windows and the printout.



Reset Command (Plan Menu)

Use this command to clear all the check boxes in the displayed plan.

Shortcuts

Toolbar:



Toolbar Command (View Menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Civilization II Advancement Planner, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Civilization II Advancement Planner,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Open a new advancement plan.

Open an existing advancement plan.    Civilization II Advancement Planner displays the Open dialog box, 
in which you can locate and open the desired file.

Save the active advancement plan with its current name.    If you have not named the plan, Civilization II 
Advancement Planner displays the Save As dialog box.

Display the advancement planning dialog.

Clear all the check boxes in the current plan.

Print the active plan.

Display the version and copyright information.

Presents a pointer which will allow you to click on any element of the window and receive help on that 
element.



Status Bar Command (View Menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Civilization II Advancement Planner window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index Command (Help Menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help Command (Help Menu)

Use this command for instructions about using Help.



About Command (Help Menu)

Use this command to display the copyright notice and version number of your copy of Civilization II 
Advancement Planner.



Context Help Command 

Use the Context Help command to obtain help on some portion of Civilization II Advancement Planner.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Civilization II Advancement Planner window, such as 
another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Scroll Bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size Command (Control Menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move Command (Control Menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize Command (Control Menu)

Use this command to reduce the Civilization II Advancement Planner window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.

Keys: ALT+F9



Maximize Command (Control Menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title bar.

Keys: CTRL+F10 enlarges a document window.



Close Command (Control Menu)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the program window or dialog box



Restore Command (Control Menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to Command (Control Menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Print Command (File Menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts
Toolbar:

Keys: CTRL+P



Print Dialog Box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that the Civilization Planner is sending 
output to the printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview Command (File Menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview Toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup Command (File Menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup Dialog Box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.




